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Abstract

We propose a novel framework for cross-modal zero-shot learning (ZSL) in the context of sketch-based image re-
trieval (SBIR). Conventionally, the SBIR schema mainly considers simultaneous mappings among the two image
views and the semantic side information. Therefore, it is desirable to consider fine-grained classes mainly in the
sketch domain using highly discriminative and semantically rich feature space. However, the existing deep genera-
tive modelling based SBIR approaches majorly focus on bridging the gaps between the seen and unseen classes by
generating pseudo-unseen-class samples. Besides, violating the ZSL protocol by not utilizing any unseen-class in-
formation during training, such techniques do not pay explicit attention to modelling the discriminative nature of the
shared space. Also, we note that learning a unified feature space for both the multi-view visual data is a tedious task
considering the significant domain difference between sketches and the colour images. In this respect, as a remedy, we
introduce a novel framework for zero-shot SBIR. While we define a cross-modal triplet loss to ensure the discrimina-
tive nature of the shared space, an innovative cross-modal attention learning strategy is also proposed to guide feature
extraction from the image domain exploiting information from the respective sketch counterpart. In order to preserve
the semantic consistency of the shared space, we consider a graph CNN based module which propagates the semantic
class topology to the shared space. To ensure an improved response time during inference, we further explore the
possibility of representing the shared space in terms of hash-codes. Experimental results obtained on the benchmark
TU-Berlin and the Sketchy datasets confirm the superiority of CrossATNet in yielding the state-of-the-art results.

Keywords: Neural networks, Sketch-based image retrieval, Cross-modal retrieval, Deep-learning, Cross-attention
network, Cross-triplets

1. Introduction

The recent years have witnessed the accumulation of
a vast volume of data, thanks to the availability of dif-
ferent types of comparatively cost-effective sensors. As
a result, a given phenomenon can be realized in various
forms of representations, thus providing complementary
perspectives. Given the inherent distributions shift among
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varied data modalities, it is non-trivial to jointly analyze
them within the scope of the original data space. The
modelling of a shared embedding space is necessary for
multi-modal data projection, preferably in a discrimina-
tive manner. In this paper, we are particularly interested
in the task of cross-modal image retrieval. This task is
essential since the visual data can be acquired in different
ways; for example, colour image, depth image, contour
or sketch image, etc. As far as the potential applications
are concerned, retrieving depth from the concerned RGB
image [1] for path-planning in SLAM models is a sought-
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after problem in this regard.
Amongst others, the notion of Sketch-based image re-

trieval (SBIR) is nowadays prevalent since it is easy to
obtain a rough sketch drawing for any object type. The
mental target [2] or query sample can be drawn by any
user in the absence of image instances of some obsolete
classes. Beside, sketches are a highly symbolic and min-
imalistic representation of data. In particular, SBIR finds
prominent applications in forensic studies or police inves-
tigations. By definition, SBIR systems seek to retrieve
several related colour images for a given query sketch
image. Often it is easier to quickly draw a sketch in-
stance of a query image than to find its actual data in-
stance. The problem set is hugely demanding, primarily
since the sketch and colour images are inherently diverse
in appearance and content. While their spectral and tex-
tural properties characterize natural images, shape plays
the most crucial role in understanding the sketch images.
In the same light, recent studies [3] have shown that the
ImageNet-trained convolutional neural networks (CNNs)
have an inherent bias towards texture. Hence, such CNN
cannot be directly applied to extract meaningful features
from the sketch images. Instead, we need a sophisticated
model that is deemed to increase the shape bias to improve
the overall representation, given sketch images.

Typically, the existing cross-modal retrieval systems
(including SBIR) work in a supervised setting where the
same set of semantic categories are utilized during train-
ing and inference. However, given the diversity of the
real-world objects, the retrieval model trained on a given
set of classes should generalize well to previously unseen
categories with bare minimum side information. This
condition increases the challenge of this problem a notch
higher. On a different note, zero-shot learning (ZSL) has
recently been extensively explored in image recognition.
The ZSL models are generally trained on a given set of
seen classes. The system is required to properly cate-
gorize samples coming from an entirely non-overlapping
collection of unseen classes during the inference phase
(figure 1). In addition to the visual instances, semantic
class-prototypes (one per class) are available for both the
seen and unseen data. In this regard, the ZSL problem
can be devised as a many to one mapping problem from
the visual to the prototype space given the seen classes.
It can then be utilized as the mapping function for clas-
sifying the unseen class data. The ZSL paradigm can be

Figure 1: Overview of the proposed CrossATNet model which allows
a cross-modal data retrieval, by reducing the distances of each mode of
data from a shared embedding vector.

incorporated within the SBIR framework as well. How-
ever, it has to be ensured that the mapping functions from
both the visual modalities (colour and sketch images) to
the semantic space should be modelled appropriately.

Very recently, the ZSL based SBIR systems are devel-
oped mainly in conjunction with the deep generative mod-
els [4, 5]. In this technique, given a sketch sample, the
authors try to learn the corresponding class RGB image
by generating pseudo samples corresponding to the un-
seen class prototypes. This requires access to unseen class
samples during the training time. This fundamentally
violates the protocol of zero-shot learning. They pose
the ZSL-SBIR problem as a standard supervised learning
problem of deploying the notion of adversarial learning to
align the cross-modal visual space to the semantic space.
Also, adversarial training can be unstable if the min-max
problem is not intuitively designed. The pseudo unseen
sample generation technique may fail to generate unseen
samples which exactly overlap with the original unseen
data in some feature space. On the other hand, we are
keener on making the shared feature space discriminative,
learning relevant image features given the sketch data, and
avoiding domain dependence of the shared space. We
bridge the domain gap by imposing semantic consistency
by preserving the topology of the semantic labels in the
network. If such a space can be realized during training,
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we can expect the unseen test classes also to follow the
same and yield excellent results upon deployment in the
testing phase.

To alleviate these shortcomings, we propose an
encoder-decoder based deep representation learning strat-
egy for zero-shot cross-modal retrieval problem. In the
proposed framework, we use sketch-anchored and image-
anchored cross-modal triplets to align sketches and im-
ages in the semantic space. We also recommend a novel
cross-attention network wherein we use a sketch-guided
feature extraction strategy from images. This helps in
approximating the complicated image-sketch mapping-
function by enabling focus on specific parts of the input
image. To reduce the domain gap between the two modal-
ities, we preserve the topography of the semantic labels in
the embedding space. This reduces the confusion of as-
signing incorrect attribute information to a cluster during
the inference phase. The semantic information is fed to
the network by forming a semantic topology graph and
injecting the graph convolution network (GCN) features
to the semantic vector. Finally, to incorporate a speedy
retrieval framework, we use a hashing function to convert
the shared feature space to ternary bits. This increases the
efficiency of the network. In the following, we summarize
the significant highlights of the proposed models:

1) We introduce a novel CrossATNet framework which
constructs a shared discriminative features space for effi-
cient sketch-based image retrieval. 2) Some of the high-
lighting aspects of CrossATNet are, a) cross-triplet, b)
cross-attention, and c) ensuring semantic consistency. 3)
We consider both real-valued and hash-code based shared
space to analyze the trade-off between accuracy and re-
trieval time. 4) Results on Sketchy and TU Berlin are
promising, and the robustness of the model is tested with
several ablation studies.

2. Related Works

Considering the primary attention of our paper, we
briefly discuss the relevant emerging works in image re-
trieval in-line with (i) cross-modal data and (ii) zero-shot
learning.

Retrieval from cross-modal data: Some of the early
works in data retrieval was done by [6, 7] in single modal
image retrieval. However, in recent times, the focus has
shifted to more challenging cross-modal data retrieval

tasks given its wide applications in different domains.
Most of these researches are based on image-text cross-
domain retrieval [8]. There are also a few works in the
image to its depth retrieval [1], gaining its popularity pri-
marily after the LiDAR point cloud data became avail-
able. Another attempt in this line has been for retrieving
image-speech cross-modal data [9]. Efforts for solving
SBIR has also gained motion after the sketchy database
came up. [10, 11, 12, 13] are a few of the notable works
in this line. However, it can be noted that all these algo-
rithms were designed for SBIR, and not the vice versa.
Interestingly, many researchers have extended retrieval
techniques to irregular domains using graph convolution
networks [14, 15], and point-CNN based techniques [16].

Zero-shot learning (ZSL): Zero-shot learning is be-
ing able to solve a task, despite not having any training
example of that class, and just by using some seman-
tic information. [17] provides a complete comprehen-
sive study in the recent advances in zero-shot learning
problems. One of the early notable work was by [18].
The ZSL concept mainly gained attention from this work,
and since then, it has been studied extensively. In ZSL,
usually, some lateral information is required to transfer
the knowledge learned in the seen classes to the unseen
classes. Often, this lateral information is realized by vi-
sual semantic mappings [19]. People have also come up
with understanding the attribute mappings in a semantic
space, which can be manually defined [20], or by using
Word2Vec embeddings [21], or by using a sentence de-
scription [22]. Currently, the GAN based architecture
is the commonly used framework for ZSL. Here, given
an unseen sample and its prototype, the network gener-
ates a pseudo-unseen sample of a different mode of data
[23]. Presently, various detection and cross-modal re-
trieval frameworks are achieved, apart from the classi-
fication task in ZSL. [24] proposed a coordinated joint
multi-modal embedding space for audio-visual classifica-
tion and retrieval of videos, using ZSL.

To the best of our knowledge [5, 4, 21, 25] are presently
the state-of-the-art methodologies that exist in the litera-
ture for zero-shot SBIR. It may be noted that while [5, 21]
use a generative adversarial network (GAN) based ap-
proach for this task, [4] use a graph-convolution network
for aligning sketches and images in the shared semantic
space. The authors in [25] advocate the importance of do-
main adaptation by transferring the knowledge acquired
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from ImageNet to their sketch data to improve the model’s
transferability. In another study, [26] also came up with
a stacked adversarial-based network for ZSL SBIR. How-
ever, as of now, [21] and [25] remain the state-of-the-art
architecture in ZSL: SBIR, and hence have been used for
comparison.

We want to emphasize that our model is a robust cross-
modal retrieval framework in contrast to the few existing
methods on sketch-based image retrieval. Furthermore,
It also encodes the image-based sketch retrieval informa-
tion. Current works in SBIR [21, 25] exploit a genera-
tive framework which typically requires sketch samples
to learn the corresponding class RGB image by generat-
ing pseudo samples. This procedure requires access to un-
seen class samples during the training time. Therefore, it
fundamentally violates the protocol of zero-shot learning.
Our model is an encoder-decoder framework where we
use the concept of cross-triplets for aligning the image-
sketch modality in the feature space. We also preserve
the topology of the semantic space using a minimally-
connected graph, which helps in bridging the domain gap
between the two modalities. We also introduce a novel
cross-attention framework to extract a sketch-guided fea-
ture extraction from images to handle the classes which
have highly-cluttered features.

3. Methodology

Preliminaries: Let X and Y denote the two incoming in-
put streams to the network corresponding to sketches and
images, respectively. Under this setup, we aim to retrieve
the top-k images from X/Y, given a query image from
the modality Y/X. For this purpose, we subdivide the
data into train and test classes, namely the seen and the
unseen classes as defined previously in such a way that
X = {Xs ∪ Xu}. Here s denotes the seen training classes
and u denotes the unseen test classes, We impose the strict
constraint that Xs ∩Xu = ∅. Similarly, we also subdivide
the Y data into the seen and the unseen data classes. Let
us define the label set for the data classes asZ and the se-
mantic class prototypes for the same asW. The semantic
prototypes are a unique description of each class.

The model is trained using only the seen instances,
while the unseen instances are deployed during the in-
ference phase. In this work, we primarily aim to design
a domain-agnostic mapping between the different data

modalities in the visual space and the semantic space. The
overall architecture of our proposed framework is shown
in terms of a block diagram in figure 2.

3.1. Overall CrossAT:Net Architecture
We use a two-stage training process as described below

to design our framework.

1. We first extract the primary level features from the
image and sketch instances by training modality-
specific classifiers.

2. Next, we carry out the training of the CrossAtNet
framework, which primarily consists of an encoder-
decoder-based model to carry out the visual space
to semantic space mapping using a cross-attention
network.

To extract the primary level features for both the data
modalities, we perform transfer-learning from a standard
pre-trained network, trained on the Imagenet dataset. We
then fine-tune them as per our dataset and its classes for
both the modalitiesXs andYs. Both the modality-specific
classifiers are trained separately to preserve the domain-
specific information. For this purpose, we use the VG-
GNet and the ResNet pre-trained networks for the initial
weight-initialization for the subsequent stage on (Xs and
Ys), using the labels fromZs.

We initialize the second stage by the network weights
obtained from stage I. We aim to learn the shared latent
space features of both the modalities trained. The model
should be trained so well on the seen classes that they
perform equally well on unseen class instances when de-
ployed during the inference phase. The latent shared fea-
tures space denoted as V should be designed in a way such
that it data instances fromXs andYs under similar classes
should be closely aligned to their corresponding semantic
information feature Ws. The proposed framework has
mainly four branches: visual encoders, semantic encoder,
cross-attention network, and a decoder network. The ar-
chitectures of these branches are described in the follow-
ing subsections.

3.1.1. Visual Encoders:
For the visual data inputs from the streams Xs and Ys

we use encoder functions fx(θx) and fy(θy), where θx and
θy are the learnable parameters for the sketch and the im-
age data streams, respectively.
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Figure 2: Overall pipeline of the proposed CrossATNet architecture for a zero-shot retrieval from a cross-modal database, by projecting the data
samples on a shared semantic space. The network uses cross-attention to extract sketch-guided features from images. The network is trained on the
seen classses by forming cross-triplets, and tested on unseen classes. With the help of the projection layer, retrieval from unseen class are possible.

To extract the image features, we use a sketch-guided
cross-attention network. To realize this, the input weights
received from the stage I from the sketch module X is
branched, with one branch fed to the encoding function
fx(θx), and the other branch is connected to the cross-
attention branch (encoded by fatt(θatt)). Again, θatt here is
the learnable parameters for this set of encoding. For real-
izing the cross-attention network, we take the inputs from
stage I and use a global-average pooling layer.
This is then followed by 2-layers of fully-connected lay-
ers. The output of this is finally passed through a Sigmoid
function. This entire architecture constitutes the cross-
attention network module. The output of this encoder is
then directly multiplied with the output from the image
encoder ( fy(θy)).

3.1.2. Semantic Encoders:
The semantic information is a unique description of

each class label. So the total number of different semantic
vector presents would be the number of training classes.
We encode the semantic information similar to the visual
encoder part by using the mapping function fw(θw), where
θw is its corresponding set of learnable parameters. In

most of the existing work, a distributed word-vector em-
bedding vector is used for each class name. Most com-
monly, this is achieved by using the standard word2vec
encoding. The word2vec module is pre-trained on large
natural language databases, which leads to the preserva-
tion of the English language word topography in the se-
mantic space. For example, the embedding vector for the
word cat should be closer to that of dog in the semantic
space, than it would be with that of Airplane. Fig-
ure 3 illustrates this preservation of the semantic topog-
raphy within different words through an example. We
take the semantic encoding from two network branches,
i) word2vec encoding, and ii) semantic-topography graph
preservation. For the latter part, we create a minimally-
connected graph of the nearest topographic classes and
use a graph-convolution network to propagate this infor-
mation onto the latent shared space. Preserving the topol-
ogy of the classes in the network helps in reducing the
domain-gap between the different modalities by aligning
the classes of the two domains in a similar way. The
encoder function fw(θw) has a series of fully-connected
layers, which basically encodes the projections from the
word2vec module and the graph module together in the
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Figure 3: A hierarchy-graph structure by constructing minimum span-
ning tree of the Word2Vec features of the labels.

semantic space.
However, it is not ensured whether this semantic infor-

mation is directly propagated in the shared latent space
given the non-linear mappings performed at each neuron.
This is a severe obstacle in ZSL where the unseen samples
are mapped trivially in the latent space, considering that
i) model is trained only on the seen classes, ii) there is
significant distributions difference between the seen and
unseen visual samples. Hence, we consider the following
two different design protocols for the semantic branch.

• The semantic encoder is defined as a series of fully-
connected layers to project the seen class prototypes
Ws onto the shared feature space. However, in this
case, the original semantic space topology may not
be preserved in the latent space.

• We use the word2vec features along with the graph
G, encoding the neighborhood topology of Zs, to
form the semantic vectorWs. We use a graph con-
volution network (with graph convolution and graph
pooling layers) to encode G, and a fully-connected
layer to fuse the word2vec and graph features to form
the semantic vectorWs.

3.1.3. Cross-modal reconstruction networks
We use two reconstruction branches which reconstruct

the cross-modal data instances from a given modal data.
We define this decoding network with the decoder func-
tions gxy(θxy) and gyx(θyx). When we provide the fea-
ture embedding of the sketch data, i.e fx(Xs

c) and en-
code it using the decoder network gxy( fx(Xs

c)), we get
the feature embedding of the corresponding label image
data instance, fy(Y s

c ). Here, c denotes a particular label

class. Hence, given the feature encoding of one stream,
we can reconstruct the encoding of the complimentary
stream. The decoder network effectively acts as a regu-
larizer function and helps in achieving domain invariance
in the shared latent space.

3.2. Hashing

The shared space that has been realized is real-valued.
This requires Euclidean distance measures for searching
during the inference phase. If we transform the shared
features into a ternary space, we can use hamming dis-
tance measures for speedy retrieval. The performance of
a model is predominantly dependant on two things: ac-
curacy and efficiency. While it is crucial to improve the
accuracy of a model, we should not completely ignore the
efficiency aspect. Hence in this regard, we add a hashing
module that encodes the embedding space into ternary bit
strings, which comprises of -1, 0, and 1. This helps in
attaining a higher efficiency of the model as the compar-
isons can be performed by using simple XOR operations
during retrieval. We use the standard Signum function,
as defined in equation 1 for hashing, where X is the con-
cerned modality of the input data stream. We denote the
learned transformations in this step as Wt. We refer to this
learned shared space, subjected to the hashing function
as H. The hashing function hence transforms the shared
feature space from V to H.

H = S X = sgn(Wt × fX(X)) (1)

3.3. Objective Function

In order to realize the latent space H, we introduce the
following loss functions to the network.
a) Cross-modal latent loss (Lcmd): It is desirable to get
the visual encoding of both the data streams adjacent in
the shared feature space by projecting them onto a com-
mon entity. To achieve this, we reduce the distance be-
tween the visual encoding of both the data of the same
class (xs

i , y
s
i ) to the semantic vector encoding of the same

class ws
i . We reduce the distance by minimizing the mean-

square error (MSE) between them. This procedure mainly
helps in bringing down the cross-modal intra-class vari-
ance. We define this loss function as,

Lcmd = || fx(Xs
c) − fw(Ws

c)||2F+|| fy(Ys
c) − fw(Ws

c)||2F (2)
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Here, F represents the Frobenious norm, defined as the
square root of the sum of the absolute squares of the ma-
trix elements.
b) Cross-triplet loss (Liii): We add a cross-triplet loss
to reduce the intra-modal distances while increasing the
inter-class distances in the shared feature space. To ex-
tend this loss to a cross-modal setup, we use two types
of triads. One set of triads are constructed by taking an
image as an anchor and using the same class sketch in-
stance and a different class sketch instance. This scheme
is described by the equation 3. The other set of triads are
formed by taking a sketch instance as an anchor and its
same corresponding class and other class image instance
along with it. This set of triads are described by equa-
tion 4.

L3a = max
(
d(fy
(
Ys

c
)
, fx
(
Xs

c
)
) − d(fy

(
Ys

c
)
, fx

(
X̃s

c

)
) + α, 0

)
(3)

L3b = max
(
d(fx
(
Xs

c
)
, fy
(
Ys

c
)
) − d(fx

(
Xs

c
)
, fy

(
Ỹs

c

)
) + α, 0

)
(4)

Here, we use Ỹs
c to denote a seen image instance of any

class other than c and d() to denote the Euclidean distance
between any two vectors. α denotes the heuristically cho-
sen margin value, which pushes apart the different classes
beyond that minimum distance. The image-anchored L3a

loss and the sketch-anchored L3b loss together comprises
of the cross-triplet loss Liii.
c) Decoder loss (Ldl): To make the shared features
domain-agnostic, we use a decoder loss in the reconstruc-
tion sub-branch of the network. To achieve this, we take
the visual encoding of a data instance from a particular
modality and reconstruct the visual encoding of instances
from the alternate modality (of the same class c). This
helps us in achieving domain-invariance in the shared fea-
ture space as we taper their distribution-gap. The idea is
to make the out of the decoder function gxy( fx(Xs

c)) near-
equal to fy(Ys

c) (similarly for the other decoder function),
hence reducing the distribution-gap between the different
modalities. The sketch and the image data vary consider-
ably in the visual feature space due to the absence of tex-
ture information in sketches. This loss helps in class-wise
aligning the two different modalities better in the decoder
space. The loss function is defined in equation 5.

Ldl = ||gxy( fx(Xs
c)) − fy(Ys

c)||2F+||gYX( fy(Ys
c)) − fx(Xs

c)||2F
(5)

Classification loss (Lce): Finally, to make the shared fea-
ture space sufficiently discriminative for both the modali-
ties, we inject the class information. This helps in increas-
ing the inter-class distances in the visual encoding space.
We use the standard cross-entropy function as defined in
equation 6. We take the cross-entropy loss of the hashed
encoding to make the hashed space sufficiently discrimi-
native.

Lce = CE (S A) + CE (S B) (6)

The overall objective function is the weighted sum of
all the loss functions, as mentioned above. The weights
act as momentum in the network. The final objective
function for our proposed framework is given in equa-
tion 7.

L = λ1Lcmd + λ2Ldl + λ3Liii + λ4Lce (7)

The presence of multiple loss functions transforms the
problem into a non-convex optimization problem. How-
ever, when each loss is considered individually for the op-
timization while keeping all the other losses constant, the
problems transform back to a convex optimization prob-
lem for that loss. Likewise, if we iteratively perform an
iterative-shrinkage gradient descent for each loss individ-
ually, the network can be trained efficiently.

3.4. Inference
Cross-modal retrieval: Once the network is trained, we
get the shared feature space H. To find the top-k retrieved
data instances of a query q, we first find its representation
in the shared embedding space and search for its k-nearest
neighbour (k-NN) feature instances using Euclidean or
Hamming distance, depending on the variant of our ar-
chitecture. These are the top-k retrieved data instances.
For a query xu

i from X, we find the top-k retrieved data
instances from Y, and vice versa.
Unimodal retrieval: Likewise, for a query xu

i from X,
we find the top-k retrieved data instances fromX, and vice
versa. The overall framework of the proposed architecture
is demonstrated in algorithm 1.

4. Experiments

Datasets: We validate our model by performing
the experiments on two standard benchmark datasets:
Sketchy [27] and TU-Berlin [28] dataset.
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Algorithm 1 The proposed training and inference stage
Input: {Xs,Ys,Ws,Zs}

Output: Unified representations H.
1: Stage 1: Normalize and pre-train Xs and Ys.
2: Stage 2: Find the Word2Vec embeddings ofZs.
3: Construct a topography graph G and generateWs.
4: do
5:

min
θx,θy,θxy,θyx

λ1Lcmd + λ2Ldl + λ3Liii + λ4Lce (8)

6: while until loss convergence
7: return S X and S Y (Projection from H)

Input: xu
i ∈ X

u or yu
i ∈ Y

u andWu

Output: Top-K retrieved data.
8: Cross-modal zero-shot retrieval using k-NN.

The Sketchy dataset [27] is a collection of a large
number of sketches and images of the same class labels.
Each image/sketch instance has multiple corresponding
sketches/images. There are 125 different classes. Each
class has 100 images, making it a total of 12,500 images.
Similarly, for the sketches, there are multiple sketchers for
each image. So the number of sketches vary in each class.
There are a total of 75,471 sketches distributed over 125
categories. For our ZSL framework, we randomly select
25 classes as the unseen classes for the inference phase
and use the rest for the training purpose as the training
dataset.

Similarly, the TU-Berlin dataset [28] also has multiple
unpaired sketch and image instances. There are a total
of 250 classes in this dataset. Eight hundred images in
each class and a variable number of sketches per class.
The total number of sketch instances over 250 classes is
204,489. For our ZSL framework, we randomly select
30 classes as the unseen classes for the inference phase
and use the remaining 220 for the training purpose as the
training dataset.
Model Architecture: To train the stage I of our network,
we use the standard VGG-16, ResNet-50, and ResNet-
101 pre-trained model and transfer the knowledge to our
dataset. The model is then fine-tuned by minimizing a
cross-entropy loss function to boost the descriptiveness of
the features. These weights are then used for the initial-
ization of stage II. While we test the performance of our

network on three different pre-trained models, we report
the final performance with the VGG-16 model to maintain
fairness in the comparative study with the literature. The
pre-trained network yields a 2048-d vector. We train the
system using a momentum optimizer as it helps to accel-
erate SGD in the relevant direction and dampens oscilla-
tions. We choose a learning rate of 0.001 heuristically.

To train the Stage II of our network, we train the se-
mantic encoder first. For the text-based model, we extract
the 300-d word2vec features of the label names of the
datasets. For the graph-based model, we created a |Ys|

dimensional distance matrix. The distance matrix was
constructed by finding the Euclidean distances between
the Word2Vec embedding of each class. A hierarchy-
graph was constructed by taking the minimum spanning
tree (MST) of this edge matrix. After obtaining the graph
structure, we performed one layer of graph convolution.
An auto-encoder was then used to combine the graph-
based and the text-based models and construct a powerful
reduct, capable enough of having a discriminative knowl-
edge power (i.e., fw()). The auto-encoder is designed to
bring down the dimension of the feature vector to 64.

To realize the visual encoder part of our network, we
use a series of convolution neural network layers, fol-
lowed by a fully-connected layer for both fx() and fy().
For the cross-attention module, we branch out a network
from the sketch encoder and subject it to a global average
pooling layer. This is then followed by two consecutive
fully-connected layers and a sigmoid function to mask
out the attention part. We then take the scalar product of
this output and the visual encoding from the image branch
fy(θy) and use that as the new fy(θy).

For the decoder part, we use a single fully-connected
layer placed after the last layer of the visual encoders.
We put a batch normalization layer after the CNN lay-
ers and a drop out layer after the fully connected layers.
We have also induced non-linearity into the network by
placing leaky˙ReLU() layers after the drop-out functions.
For the second stage, we use an Adam optimizer to mini-
mize the loss function using a stochastic gradient descent
procedure. Again, the learning rate is heuristically chosen
as 0.001. The model was trained by setting the α value as
1 (equation 3) and a batch size of 256 for 200 epochs.
Training and Evaluation Protocol: We train the network
by selecting random images and sketches and forming
their corresponding triads. We train the network by ap-
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Table 1: Performance of the proposed CrossATNet framework for sketch-based image retrieval on the Sketchy and TU-Berlin dataset. Here, †
represents the algorithms that have a hashed vector-representation.

Task Sketchy TU-Berlin Size
mAP P@100 mAP P@100

Siamese CNN [29] 0.183 0.143 0.153 0.122 64
SaN [30] 0.129 0.104 0.112 0.096 512

SBIR 3D Shape [31] 0.070 0.062 0.063 0.057 64
DSH (Binary) † [28] 0.171 0.231 0.129 0.189 64 †
GN Triplet [27] 0.204 0.296 0.175 0.253 1024
SSE [32] 0.154 0.108 0.133 0.096 100
JLSE [11] 0.131 0.185 0.109 0.155 220

ZSL ZSH [12] 0.159 0.214 0.141 0.177 64
SAE [13] 0.216 0.293 0.167 0.221 300
ZS-SBIR [5] 0.196 0.284 0.005 0.001 1024
EMS [33] - - 0.259 0.369 512

ZSL:SBIR CVAE [5] 0.225 0.333 - - 4096
SEM-PCYC [21] 0.349 0.463 0.297 0.426 64
SAKE [25] a 0.547 0.692 0.475 0.599 64
CrossATNet 0.413 0.487 0.327 0.427 64
ZSIH † [4] 0.258 0.342 0.223 0.294 64†

Hashed ZSL:SBIR EMS † [33] - - 0.165 0.252 64†
SEM-PCYC† [21] 0.344 0.399 0.293 0.392 64†
SAKE [25]† 0 0.364 0.487 0.359 0.481 512 †
CrossATNet † 0.365 0.411 0.316 0.404 64†

aSAKE uses the ImageNet data as auxiliary information during the training process which greatly helps in boosting up the performance of the network. Hence, direct
comparison with this framework is not fair. Further details are given in the discussion section.

proximately using 2,00,000 sketch-anchored and image-
anchored triads. To avoid any training bias due to im-
balance number of samples in the two modalities, we
feed an equal number of triads of both types in each
batch. To evaluate the performance of our model, we
use the standard mean Average Precision (mAP) value
and the P@100 (precision for top-100) scores and fol-
low the training and evaluation protocol of [21]. For the
ZSL:SBIR part, we use just the sketch-anchored triplets to
have a fair comparison with the state-of-the-art method-
ologies. Such training boosts the SBIR part of the per-
formance of our network. For the cross-modal retrieval
part, we train the model with both the sketch-anchored
and image-anchored cross triplets.

5. Discussions

The train and test classes were chosen randomly for the
experiments to avoid any bias induced while training. Ta-
ble 1 shows the comparison of the performance of various
models present in the literature on the TU-Berlin and the

Table 2: Performance of the proposed CrossATNet framework for cross-
modal retrieval on the Sketchy and TU-Berlin datasets in terms of mAP
and precision at top-100 (P@100) values. Here, † represents the algo-
rithms that have a hashed vector-representation.

Task Sketchy TU-Berlin
mAP P@100 mAP P@100

Sketch→Image 0.372 0.430 0.302 0.322
Sketch→Image † 0.347 0.410 0.312 0.376
Image→Sketch 0.359 0.312 0.289 0.298
Sketch→Sketch 0.318 0.343 0.238 0.257
Image→Image 0.561 0.594 0.465 0.466

Sketchy dataset. The current state-of-the-artwork in lit-
erature closest to our work is given in [21, 25]. We also
show a few more comparison with [29, 30, 31, 28, 10, 27,
32, 11, 12, 13, 5, 33, 4]. Here, † represents the algorithms
that have a hashed vector-representation. We report the
performance of our model for both cross-modal and uni-
modal retrieval in table 2.

For the non-hashing case, SAKE exceeds the perfor-
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mance of CrossAtNet for the majority of the cases, while
for hashing case, the results are almost comparable. How-
ever, our framework can exceed the performance of all
the generative ZSL:SBIR and the majority of discrimi-
native ZS-SBIR approaches. It is visible that while for
the non-hashing case, SAKE gets the better of CrossAt-
Net for the majority of the cases and for the hashing case,
we outperform SAKE on the Sketchy dataset. The sig-
nificant distinctions between SAKE and other zero-shot
SBIR frameworks that are responsible for the success of
SAKE are (i) SAKE uses the entire ImageNet data as
auxiliary information during training to combat the catas-
trophic forgetting, which greatly helps in generalization to
unseen-class samples in ZS-SBIR. Precisely, SAKE uses
the rich semantic space of Imagenet and deploys a do-
main adaptation paradigm to ensure that the sketch-image
data in ZS-SBIR comply with the semantic topology of
Imagenet. However, this additional information is sel-
dom used in the zero-shot learning literature [21], and we
also have not used the same in CrossAtNet. (ii) SAKE
uses a conditional auto-encoder based shared feature ex-
tractor coupled with ResNet-50 (CSE-ResNet50) for the
sketches and photos. This definitely contributes to boost-
ing the performance of SAKE. In spite of this, we see that
standard VGG-16 based CrossAtNet achieves superior re-
sults to the literature and even outperforms SAKE in a few
cases.

The framework not only encodes the SBIR mapping,
but it also encodes the inverse IBSR mappings. Table 2
how well the proposed framework can retrieve images
from sketches, sketches from images, images from im-
ages, and sketches from sketches. Fig. 4 shows a few ex-
amples of the top-5 retrieved images, given a query image
(first column). The two primary purposes of our frame-
work were to make the shared feature space discrimina-
tive and to reduce the domain-gap between the two modal-
ities. Fig. 6 (a) and (b) shows the t-SNE plots of five ran-
dom classes from the shared features of the images and
features, respectively. It can be seen that the designed
features space is discriminative. Fig. 6 (c) shows the over-
lapped scatter plots of the two modalities to highlight how
overlapping the feature space is. The image features are
presented by crosses, while the sketch features are shown
by dots.

While performing the experiments, we observed that
there is much confusion between very closely related

Figure 4: Top retrieved results of zero-shot cross-modal retrieval
on the unseen classes. Alternate rows represent Sketch→Image and
Image→Sketch retrievals.

Duck Swan Chicken Penguin Owl

Elephant Squirrel Airplane Rabbit Pig

Figure 5: Few examples from confusion classes are represented in the
first row. The second row shows some idiosyncratic sketches.

classes, like Swan, Duck, Owl, and Chicken. The first
row of Fig. 5 shows a few instances from these classes.
Upon close examination, we could observe that while
the photos of these classes were well distinguishable, the
sketches were tough to be recognized even with human
evaluation. The main feature distinguishing them is the
texture and colour properties, which obviously cannot be
represented in sketches. Also, we noticed that there were
several idiosyncratically drawn sketches like shown in the
second row of Fig. 5. There were multiple instances in
each class, which just had “press reset” written in it. An-
other interesting observation that we made during the crit-
ical analysis of the results was retrieving uni-modal pho-
tos was achieved with much higher precision than retriev-
ing the uni-modal sketches. We presume that this is pos-
sibly due to the lack of highly informative texture data
field.
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(a) Images (b) Sketches

(c) Images and Sketches

Figure 6: Two-dimensional t-SNE scatter plots of the shared feature
space of images, sketches, and both of them together for five random
unseen classes. The different colors represent the embeddings of dif-
ferent classes. The image embeddings are plotted by hashes, while the
sketch embeddings are plotted by dots.

Hyper-parameter tuning of equation 7 (λ1, λ2, λ3, and
λ4): We followed the standard procedure of the ZSL com-
munity by splitting the training data into (pseudo-seen and
pseudo-unseen) for the purpose of cross-validating the pa-
rameters in equation 7. The network performance under
these hyper-parameter settings in terms of mAP values on
the Sketchy dataset is shown in table 3. We experiment the
performance of the network by choosing different values
of λ ranging from 0.01 to 1. We choose the parameters λ1
to λ4 after cross-validation. A sensitivity analysis on the
parameters is shown in Table 3. We choose the combina-
tion of hyper-parameters that yield the best performance
in the final model.

5.1. Ablation Studies

Effect of Graph-based model: To investigate the con-
tribution of graph structure in preserving the hierarchy of
the labels in the semantic space, we study the performance
of the proposed model with and without using the graph
structure. We get the projection layer values just from
the Word2Vec embeddings, followed by a set of auto-
encoders to bring down the dimension of the projection

Table 3: Sensitivity analysis of the hyper-parameters for the final objec-
tive function by varying the values of the λi, ranging from 0.01 to 1. The
results are reported in terms of the mAP values for the Sketchy dataset.

Values λ1 λ2 λ3 λ4

0.01 0.36 0.37 0.32 0.41
0.1 0.41 0.41 0.29 0.39
1 0.11 0.19 0.41 0.38

vector. The leverage of preserving the hierarchy informa-
tion of the labels can be seen from Table 4.
Effect of decoder loss (Lrcs): The decoder loss was intro-
duced in the model to achieve domain-independence be-
tween X andY. This loss reconstructs the feature embed-
ding of the alternate modality from the shared-embedding
of a given modality of data. Minimizing the decoder loss
in addition to the overall loss function boosts the perfor-
mance of the framework significantly. A definite fall in
the performance of the network can be seen in table 4,
without the decoder loss.
Effect of cross-triplet loss (L3lt): The cross-triplet was
added to the network to bring the same class samples of
different modalities nearby, while pushing the different
classes of different modalities far apart in the embedding
space. While performing a gradient descent on this loss
function we can see a clear boost in the performance of
this model from table 4.
Effect of fixed/latent semantic space: To study the ad-
equacy of the semantic space, we conduct two set of ex-
periments. Firstly, we train the model with the Word2Vec
features as the fixed semantic vector. In the second set of
experiments, we keep this vector learnable and learn the
optimum 300-d semantic vector using the Word2Vec and
a graph hierarchy during the training process. It can be
seen from table 4 how the latent semantic vector outper-
forms the fixed projection vector.
Effect of Pre-training: To investigate the effect of bias
introduced in the model due to the pre-training network,
we perform our experiments using three different pre-
trained models VGG-16, ResNet-50, and ResNet-101. It
can be seen from table 4 that a ResNet-50 trained model
outperforms the VGG-16 trained model, while ResNet-
101 on the other hand performs a little inferior to ResNet-
50 in the Sketchy dataset. For the TU-Berlin data, VGG16
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Table 4: Ablation study (with mAP values) with different experimental
setups to analyze the effect of each of these dependencies on the pro-
posed model.

Task Sketchy TU-Berlin dim
Total model 0.413 0.327 64
Without Graph 0.386 0.311 64
Without decoder loss Lrcs 0.215 0.178 64
Without triplet loss L3lt 0.198 0.217 64
Fixed semantic space 0.243 0.1987 300
Pretraining with VGG-16 0.413 0.327 64
Pretraining with ResNet-50 0.421 0.325 64
Pretraining with ResNet-101 0.398 0.309 64
Seen+Unseen class graph 0.422 0.331 64

yields better results than the other two. However, to keep
the training protocol same for the comparative study, we
report the VGG16 results in the table 1.
Effect of graphs from seen and unseen classes: In
this experimental studies, we used two types of graphs
while training. In first case we used the complete set of
all classes to construct an initial minimum spanning tree
from all the labels and learn the attribute space from it.
In the second case, we just used the seen class labels to
construct the graph and for the testing stage, we used this
learning to get the attribute vectors. It is noted that us-
ing the complete graph yields better retrieval results than
using just the seen class label graphs. However, in order
to be fair and consistent with the other comparative algo-
rithms used, we have shown our results with the one with
just the seen class semantic space training.

6. Conclusion

In this study, we proposed a novel deep representation
learning technique for zero-shot sketch retrieval. The pro-
posed framework is also robust to cross-modal and uni-
modal retrieval set-up, using which we can also get the
image-based sketch retrieval for the unseen classes. The
network mainly brings closer the sample embeddings of
different modalities in the shared space with the help of
cross-triplets and an cross-attention network. By utiliz-
ing the novel cross-attention module and a well preserved
semantic topography, we were able to beat the state-of-

the-art models which exploit the standard protocol of a
ZSL:SBIR framework. We also outperform the SAKE
framework in a few cases, wherein the authors make use
of auxiliary datasets to boost up their network perfor-
mances considerably. The foremost essence is to de-
sign the shared embedding space sufficiently class-wise
discriminative enough and adequately domain-wise in-
variant. We can extend the framework to form a self-
supervised architecture or explore the possibility of ex-
tending it to an incremental learning framework.
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